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Viewing Charts, Reports, and

Fund Holdings in Morningstar Direct™"

Once a set of investments is available as either a list or search criteria, additional
research can be done with these investments not just by swapping out different data
sets in the grid view, but also by leveraging several options available from both the
Actions menu and the right-click menu.

This exercise guide focuses on accessing charts, reports, and holdings information from
the Workspace module and Presentation Studio, but they are also available from the

Local Databases, Global Databases, and Performance Reporting modules. Please note
these exercises require the desktop edition (3.20.011) of Morningstar Direct™ or later.

& Note: Find the desktop edition version number by clicking Help > About Morningstar Direct.

The following exercises are covered here:

» Exercise 1: View the Growth chart for a fund (page 5)

» Exercise 2: Show Growth chart and table (page 8)

» Exercise 3: Add an Investment (page 10)

» Exercise 4: Change the data showing on a chart (page 11)

» Exercise b: Save a chart as a template (page 11)

» Exercise 6: Send Growth chart to Presentation Studio (page 12)

» Exercise 7: Correlation Matrix exercise list (page 13)

» Exercise 8: Generate a Correlation Matrix chart (page 16)

» Exercise 9: Update the Correlation Matrix chart settings (page 17)

» Exercise 10: Save a chart as a template (page 18)

» Exercise 11: Generate a Historical Sustainability chart (page 19)

» Exercise 12: Compare two funds (page 20)

» Exercise 13: Generate a Holdings-Based Style Trail chart and Holdings-Based Style
Map chart (page 21)

» Exercise 14: Save a Presentation Studio template (page 25)

» Exercise 15: Generate the Global Fund Report (page 26)

» Exercise 16: Generate the Morningstar Report (page 31)

» Exercise 17: View a fund's holdings (page 32)

» Exercise 18: Retrieve a fund’s owner information (page 33)

Overview
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 1: View the Growth chart for a fund

Exercise 1: View the
Growth chart for a fund

This exercise uses the Small Value Five Star Funds list created during the Working with
Lists Onboarding Exercise Guide. If you have not created this list, another list of funds
can be used. In addition to opening the Growth chart, users will also see how to
modify it.

The Growth chart is one of the sixteen interactive charts available in the desktop
access point of Morningstar Direct. Below is a list of the available charts:

Interactive Charts

Interactive Charts

Allocation

Historical Sustainability

Carbon Risk

Holdings Plot

Correlation Matrix

Holdings Similarity

Equity Region Exposure

Portfolio Characteristics

ESG Pillar Score

Price

ESG Product Involvement

Return Bar

ESG Product Involvement Top Exposure

Return vs Category

Fixed Income Exposure Analysis

Revenue Exposure

Global Revenue Map

Risk/Reward

Growth

Rolling Return

Historical Allocation

Style Box

Historical Drawdown

The Growth chart allows users to investigate a fund’s performance over custom
periods. The Growth chart shows a fund's performance based on how $10,000 invested
in the fund would have grown over time with dividends reinvested. To investigate a
fund from the list using the Growth chart, do the following:

1. Select the Workspace module. The My Lists page should be selected by default.
2. Double-click the US Small Value 5 Star Funds & ETFs list.

Marningstar Direct November 2021 5
© 2021 Morningstar. All Rights Reserved.

MAORNINGSTAR


http://morningstardirect.morningstar.com/clientcomm/Lists.pdf#M3.8.newlink.smallvalue
http://morningstardirect.morningstar.com/clientcomm/Lists.pdf#M3.8.newlink.smallvalue
http://morningstardirect.morningstar.com/clientcomm/Lists.pdf

Viewing Charts, Reports, and Fund Holdings in Morningstar Direc

tSM

Exercise 1: View the Growth chart for a fund

7 - -
'{ Morningstar Direct
: File New Favorites Tools

Home

Equity/Credit Research

Local Databases H
Global Databases
Performance Reporting r

-

Asset Allocation

Portfolio Management P
Portfolio Analysis r
Markets r
Asset Flows r
Presentation Studio r
Advanced Analysis P
| Workspace I r
B3 Investment Lists | Ci

[ B my Lists |

» B3 Search Criteria r

Help Search for | In This View

Ac:ticm'| Ed New | ﬁExpurtv | [&] PDF | @Refresh

Double-click this list to open it.

Mame
1 IUS Small value Five Star Funds & ETFs
2 Large Growth Desktop
3 Morningstar Prospects
4 Large Growth Test
5 Target Date Fund
G Large Growth Funds
r Large Growth Funds 2
8 Sustainable Landscape U.S. Funds Q3 2020
] Sustainable Landscape Global Funds Q3 2020
10 Sustainable Landscape Eurcpean Funds Q3 2020
11 American Century Five-Globe Funds
12  Low Cost ESG Offerings
i3 Low Cost ESG Offerings
14 Large Value Funds

a new window.

Check the box to the left of the first investment in the list.

From the Action menu, select Interactive Charts > Growth. The Growth chart opens in

My Lists

Stock Intersection

X-Ray

Filing

Documents

UK Closed End Fund News

Historical Allocation
Historical Drawdown
Historical Sustainability
Holdings Plot

Holdings Similarity
Portfolio Characteristics
Price

Return Bar

Return vs Category
Revenue Exposure
Risk Reward

Rolling Return

Style Box

:|\ Action_vl A A v ¥ View Snapshot - | M save KiAdd [F Edit Data | § Sort | @, Locate | 4} Export -

I Save As » g:t;"w Ticker ISIN g:::::l‘:yrugl:up
Add To »

F Move To utional US Dollar AFDZX US98147A2877  Equity

r Delete US Dallar FCPVX US3163898329  Equity

r Settings ¥ Value Us Dollar QRSVX US1048262018  Equity

It Reports L2 US Dollar FRVLX US3551483056  Equity

|-I Interactive Charts » Allocation US55278M4078  Equity

r Risk Model L Carbon Risk US66538A2996  Equity

r Presentation Studic Charts » Correlation Matrix US69374H8575  Equity

r Premium/Discount Equity Region Exposure US7809057828  Equity

r View Holdings L ESG Pillar Score US91915R6320 Equity

r View Owners L ESG Product Involvement US9229087930  Equity

r View Fundcode Info ESG Product Involvement Top Exposure US9264643894  Equity

r Performance Attribution L Fixed Income Exposure Analysis US92647N8737  Equity

[ Portfolio Analysis Global Revenue Map US9333102039 _ Equity.

[ Average Detail Report Growth US94984B4398  Equity Use the Action menu

to select this chart.
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ What capabilities exist for charts?

Charts open in a new window, and offer a number of capabilities from a series of icons What capabilities

on the toolbar. These are described in the following table: exist for charts?
Morningstar Direct - [m] X
IGth i v Wi EE LR Y I £ S Us faechace ) Note the toolbar.
2 Add to Chart
Start Date Since Inception (06/11/2015) v End Date Last Market Close (11/17/2021) v Currency US Dollar v View Chart v
5 More Settings v
25,000.00 Applied Finance
Explorer
[n_s@l._lljnnal
Russell 2000
20,000.00 Value TR USD
18,999.28
15,000.00
10,000.00
5,000.00
06 01 07 01 07 01 07 01 07 01 07 0 07
2015
This icon... Does the following...
Clipboard Copies the image to the computer’s clipboard, so it can
be pasted into another application.
PowerPoint Exports the chart to Microsoft® PowerPoint®.
Create PDF Exports the chart to a PDF.
Export Excel Exports the underlying data to Microsoft® Excel®.
Save Makes the chart available from the Chart Templates
page under the Workspace module.

Morningstar Direct November 2021 7
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 2: Show Growth chart and table

Users can show the data in the Growth chart in a chart and table format. Users can Exercise 2: Show
also update the color and weight of the line in the chart. To show the data in a chart Growth chart and table

and table format and update the color of the line, do the following:

1. From the toolbar, click View Chart > Split.

Morningstar Direct — O X
Growth  Actions v Display Preferences  Edit Investments Export v = Send Us Feedback )
Add to Chart
Start Date Since Inception (06/11/2015) v End Date Last Market Close (11/17/2021) v Currency US Dollar v View Chart v |
5 More Settings v .
i Note the options for chart
_ and table. Select Split to
25,000.00 nce view both formats.
J Split
Russell 2000
20,000.00 Value TR USD
18,999.28
15,000.00
10,000.00
= 5,00000
06 01 07 0 07 01 07 (] 07 01 07 01 07
015 2 2

Marningstar Direct November 2021
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™

Exercise 2: Show Growth chart and table

2. From the top of the page, click Display Preferences. The Display Preferences window

opens in the Investments tab by default.

Morningstar Direct - ] X
Growth  Actions v Edit Investments Export v | =1 Send Us Feeﬂbzc“r ) Usa s @@inmE i@
S change the color of the line.
i The gray bars in the chart
can also be changed here.
Start Date Since Inception (06/11/2015) v End Date Last Market Close (11/17/2021) v Currency US Dollar v View Chart v
5 Mare Settings v
25,000.00 Applied Finance
Explorer
Institutional
23,036.14
Russell 2000
20,000.00 Value TR USD
18,999.28
15,000.00
10,000.00
é 5,000.00
06 0of 07 o1 07 o0 07 o1 07 01 07
015 2016 2017 2018 2020 2021
3. For Applied Finance Explores Institutional, click the Celor caret. The color
options display.
4. Select yellow then click update.
Display Preferences
nvestments Char
Name Color Line Thickness
Applied Finance Explorer Institutional [} v v
Russell 2000 Value TR US v
@. EEN Note the color options.
EEEEEN
[ | B
Marningstar Direct November 2021 9
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direc Exercise 3: Add an Investment

The Add to Chart field and Edit Investments icon above a chart can be used to both add Exercise 3: Add an
and investments and benchmarks. To add an investment, do the following: Investment

1. From the Add to Chart field, search for Fidelity Small Cap Value.

2. Select the first option. The investment is added to the chart.

Morningstar Direct = m} X
Growth  Actions v Display Preferences  Edit Investments © Reset Chart Export v [ Send Us Feedback )
Q fidelity small cap value| X
Search for the
Tick N T Exch c ) Currency US Doll View Sali investment you
icker ame ype xchange Country Currency ollar v View Split v e i Al
FCPVX FO XNAS USA
FIS\ 0 NAS USA =
d FO (NAS xst Applied Finance
C\ FO  XNAS  USA Explorer
Institutional
FIKNX FO XNAS USA
Russell 2000
Value TR USD
FCVAX FO  XNAS USA 18.999 28
FCVTX FO XNAS USA
FCVCX Fidelity Advisor® Small Cap FO XNAS USA
Value C .
QA LA
06 01 07 01 07 01 07 01 07 01 07 01 07
2015 2016 2017 2018 2019 2020 2021
Cumulative Annualized
Name Return Return Initial Value Ending Value
| Applied Finance Explorer Institutiana 130.36 1384 10,00000 23.036.14
2 Russell 2000 Value TR USD 89.99 1043 10,000.00 18,999.28

3. From the top of the page, click Display Preferences. The Display Preferences window
opens in the Investments tab by default.

4. For Fidelity Small Value, click the Color caret. The color options display.

5. Select blue then click update.

Marningstar Direct November 2021 10
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direc

tSM

Exercise 4: Change the data showing on a chart

In the Growth chart, the 10k Growth data point value is displayed by default. This
exercise shows users how to change the Growth chart to display the Cumulative
Return% instead of 10k Growth. To change the data displayed on the chart, do the

following:

1. From the 4 More Settings drop-down field, click Data Point.

2. Select Cumulative Return %.

Exercise 4: Change the
data showing on a chart

Morningstar Direct = [m]
Growth  Actions v efere Edit Inve: n © Reset Chart v = Se
Add to Chart
Start Date Since Inception (06/11/2015) v End Date Last Market Close (11/17/2021) v Currency US Dollar v View Split v
5 More Settings v
Data Point 5 Applied Finance
K Growth Explorer
Initial Value i . lnftllEI;O?il
0.00 (<) Back DataPoint | £330
Frequency Fidelity® Small
Monthly 2 i Cap Value
: @ 10K Growth ooy
= 2058494
Benchmark
Russell 2000 Value TR USD T
el 0 Yate THES Russell 2000
Return Type Value TR USD
S 18 999 28
= 5,000.00
06 01 07 01 07 01 07 01 07 01 07 01 07
2015 2016 201 W
Cumulative Annualized
Name Return Return  Initial Value  Ending Value
1 Applied Finance Explorer Institutiona 384 1000000 23,036.14
2 Fidelity® Small Cap Value 87 10.000.00 205849
3 Russell 2000 Value TR USD 1049 1000000 18,999.28

A user can save a chart as a template and retrieve it within the desktop access point of
Morningstar Direct. To save a chart as a template, do the following:

1. In the Charts window, from the Actions icon, click Save Chart. The Save As window

opens.

Select Cumulative Return %.

Exercise 5: Save a chart
as a template

WMorningstar Direct

Growth

Actions v| Display

Preferences  Edit Investments “ Reset Chart Export v

Add 1

Click Save Chart.

Start Date £ st Close (11/17/2021) v Currency US Dollar v View Split v

150.00

4 More Settings v

In the Name field, enter Growth Chart Template.
Click OK. The Save As window closes.

From the Workspace module, click Chart Templates. The new template is displayed.

MAORNINGSTAR
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™

Exercise 6: Send Growth chart to Presentation Studio

Morningstar Direct

[ Fle New Favorites Tools Help : Search for In This View ~ Go

Home

Equity/ Credit Research Action~ |k Export~ | [E] PDF | ¢ Refresh

Local Databases r Hama Type
Global Databases

performance Reporting O Price Chart Template Price
T M2 TestPrice Price
Portfolio Management
Portfolio Analysis
Markets

Asset Flows
Presentation Studio
Advanced Analysis
Workspace:

& Investment Lists
E My Lists

¥ &= Search Criteria

» B2 Repoct Templat:

Ovmer

Chelsea Beckford
Chelsea Beckford

Permission | Last Updated

Read/Write
Read/Write

2/15/2021
1/20/2021

Click the Chart
Template module.

|E Chart Templates I

» & Data Sets

¥ &5 Custom Database
E saved Reports
= Note Manager
E Retirement Plans

» E5 Group Manager

The Export menu now offers an option for Send to Presentation Studio. When this
option is selected, the Presentation Studio module opens and the chart is automatically

Exercise 6: Send Growth
chart to Presentation

added as a component to a new Workbook template. To send the Growth chart to Studio
Presentation Studio, do the following:
1. Open the Growth chart window.
2. From the toolbar, click Export > Send to Presentation Studio.
Morningstar Direct
Growth  Actions v Display Preferences  Edit Investments Export v ‘
Add to Chart Excel
-y ; - " . PDF o
Start Date Since Inception (06/11/2015) v End Date Last Market Close (11 v Select this option.
PowerPoint
Se esentation Stud
25,000.00 —
Morningstar Direct November 2021 12
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 7: Correlation Matrix exercise list

This exercise shows users how to create a list in the desktop access point of Exercise 7: Correlation
Morningstar Direct. To create a list, do the following: Matrix exercise list

1. From the Workspace module, click My Lists.

2. From the toolbar, click New. The Select Investments window opens.

Flle New Favorites Tools Help | Search for In This View - Go
Home
Equity/Credit Research Action~ | &d New || ik Export~ | [X] PDF | ¥ Refresh .
Local Databases r Name Ovmer Permission | Last Updated | # of Items Click New.

Global Databases

performance Reporting | | 1 Morningstar Open Index Project Morningstar Read Only  7/1/2019 2,576
———— [" 2  Sustainable Landscape U.S. Funds Q3 2020 morningstar Read Only  11/3/2020 373
"3 Sustainable Landscape Global Funds Q4 2020 morningstar Read Only  1/25/2021 5,061
Portfolio Management
[" 4  Sustainable Landscape European Funds Q4 2020 Morningstar Read Only  1/25/2021 4,018
Portfolio Analysis [C5  Morningstar Prospects Morningstar Read Only 1/12/2021 31
Markets e 2020 Bond Funds Web-Based Read/Write  2/10/2021 7
b [ 7  American Century Five-Globe Funds wieb-Based Read/Write  9/23/2020 a
T ———— [T 8  Blockchain Vieb-Based Read/Write  2/4/2020 1
8 Classs Vieb-Based Read/Write  5/6/2020 12
Advanced Analysis
[C 10  Combined Funds Vieb-Based Read/Write  5/5/2020 313
Workspace [T 11  Dodge and Cox FI Web-Based Read/Write 2/7/2021 19
& [T 12 ESG Consideration (12 31 19) Chelsea Beckford  Read/Write  7/31/2020 564
My Lists [C 13 ESG Model Vieb-Based Read/Write  7/23/2020 16
» B8 Search Criteria ™ 14 Fixed Income Funds Chelsea Beckford  Read/Write  1/28/2021 5
* &8 Report Templates [" 15  Garca Holdings Web-Based Read/Write  5/5/2020 P
: S el [ 16  IncomeETFs Web-Based Read/Write  2/12/2020 6
»
Data Setz (il Larne Growth Consistent helsea Beckford  Bead/Write 020 94

Marningstar Direct November 2021 13
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 7: Correlation Matrix exercise list

3. Select the Multiple Investments option.

4. Click OK. The Find Investments window opens.

Select Investments X
Select Investments

How do you want to select Investments?
MName/Ticker/ISIN/CUSIF/Secld

(O Single Investment:
(O search Criteria Open End Funds
(O My Lists

() 1mport List

Note the highlighted areas.

| oK | Cancel| Help

5. From the Within drop-down field, select Funds (Open End and Exchange
Traded Funds).

6. From the Find By drop-down field, select Ticker.
7. Enter the following tickers into the search field:

< Note: To search for multiple funds, enter multiple tickers separated by commas.

» PIGIX » BMNSX
» DFSCX » [TOT

» MGIAX » NEFRX

» NEWFX » TRMCX
» AWSHX » GSMHX
» OSMAX » FGMNX

Morningstar Direct November 2021 14
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 7: Correlation Matrix exercise list

8. Click Go. Search results appear in the Available Records box.
9. Click Add All.

Find Investments X

Within (@ Universes (O My Lists (O My Searches

|| Funds {Open End and Exchange Traded Funds) ~ ‘l

Find By |T|cl<er ™ | Begins with Contains

Include Only Surviving Investments

I PIGIX,DFSCX,MGIAX,NEWFX, AWSHX,0SMAX, BMNSX, [TOT,NEFRX, TI
:

| Go

Note the highlighted areas.

Available Records

Total records: 12

Jump to record name: | PIGIX, DFSCX,MGIAX, NEWFX, AWSHX, OSMAX, BMNSX, ITOT,

PIMCO Investment Grade Credit Bond Instl (USD,XNAS,PIGIX, Port+Perf,Oldest,R
DFA US Micro Cap I (USD,XNAS,DFSCX,Port+Perf,Oldest,RepPerf)

MFS International Intrinsic Value A (USD,XNAS,MGIAX,Port+Perf,Oldest,RepPerf’
American Funds New World A (USD,XNAS,NEWFX,Port+Perf,Oldest,RepPerf)

American Funds Washington Mutual A (USD,XNAS,AWSHX,Port+Perf,0ldest,Repf ¥
< >

Selected Records

Total records: 12

MFS International Intrinsic Value A (USD,XNAS,MGIAX,Port+Perf,Oldest,RepPerf A
American Funds New World A (USD,XNAS,NEWFX,Port+Perf,Oldest,RepPerf) e
American Funds Washington Mutual A (USD,XNAS, AWSHX, Port+Perf, Oldest,RepF
A4
Invesco Intl SmI-Mid Com A (USD,XNAS,0SMAX,Port+Perf,Oldest,RepPerf)
Baird Core Intermediate Municpl Bd Inv (USD,XMNAS,BMNSX,Port+Perf,RepPerf) ¥ ¥
< >
Remove Remove All
Help oK Cancel
10. Click OK. The funds open in the Grid.
11. From the toolbar, click Save. The Save As window opens.
12. In the Name field, enter Correlation Matrix List.
Save As
Name Correlation Matrix List Name the list
My Investment Lists 2020 Bond Funds ~
American Century Five-Globe Funds
Blockchain
Class 3

Combined Funds

Dodge and Cox FI

ESG Consideration (12 31 19)

ESG Model

Fixed Income Funds

Garcia Holdings

Income ETFs W

oK Cancel Help

13. Click OK. The Save As window closes.

Marningstar Direct November 2021 15
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise

8: Generate a Correlation Matrix chart

The Correlation Matrix chart allows users to determine how investment returns move
together (or don’t). The abjective of building a diverse portfolio is to reduce portfolio
risk by selecting investments whose returns do not move together—whose returns are
“uncorrelated.” The Correlation Matrix calculates the correlation of returns between
each pair of investments in the chart, and displays the correlation coefficients in
matrix. Please note that a maximum of fifteen investments of any type can be displayed
in the chart.

To investigate the list using the Correlation Matrix chart, do the following:

1. The Correlation Matrix list should still be open in the grid view. Check the box in the
column header to select all items in the list.

Morningstar Direct

Exercise 8: Generate a
Correlation Matrix chart

Eile Mew Favorites Tools Help Search for In This View v Go
Home | My Lists -
Egquity/ Credit Research I Actionv| & A v ¥ View Snapshot - asave kd Add |§—’e Edit Data|
Local Databases Mame Base Ticker

I~

Currency

Global Databases
Performance Reporting V1 PIMCO Investment Grade Credit Bond Instl Us Dollar PIGIX
T V2 DFA US Micro Cap I Us Dollar DFSCX

V3 MFS International Intrinsic Value A US Dollar MGIAX
Portfolio Management s

Va4 American Funds New World A US Dollar NEWFX
Portfolio Analysis Vs American Funds Washington Mutual A Us Dollar AWSHX
Markets V& Invesco Intl Smi-Mid Com A US Dollar OSMAX
Asset Flows V7 Baird Core Intermediate Municpl Bd Inv Us Dollar BMNSX
T Ve Loomis Sayles Core Plus Bond A Us Dollar NEFRX

Vs GMO SGM Major Markets VI Us Dollar GSMHX
Advanced Analysis St

W 10 Fidelity® GNMA US Dollar FGMNX
Workspace [¥ 11 iShares Core S&P Total US Stack Mkt ETF Mexican Pesa ToT
~E2 Investment Lists V12 iShares Core S&P Total US Stock Mkt ETF Us Dollar ITOT

E My Lists
b &5 Search Criteria
b &5l Report Templates

2. From the Action menu, select Interactive Charts > Correlation Matrix. The Correlation
Matrix chart opens in a new window.

Check this box to
select the funds.

Select Correlation Matrix.

Marningstar Direct
: File New Favorites JTools Help Search for In This View * Go
Home | My Lists
Equity/Credit Research | Action~ |4 A v ¥ View Snapshot ~ M save KlAdd F3Edit Data | $lsort | @
Local Databases [ savelas » Base Ticker 1SIN
Currency
Global Databases Add 1o ’
pPesfarmanceRenactinaad | Move™ it Bond Instl US Dollar PIGIX US7220058165
—— [ Delete US Dollar DFSCX US2332035045
- [¢  Settifas Y lue A US Dollar MGIAX US55273E3018
Eorfolio Nansgament [v___Repofts Ls US Dollar NEWFX  US6492801047
Portfolio Analysis f___Interactive Charts *|  Allocation US9393301067
Markets [ Risk Model » Carbon Risk US00900W5711]
FO— ~ Presentation Studio Charts  » Correlation Matrix | US0570716450
) ) F Premium/Discount Equity Region Exposure US63872R7989
Presentation Studio
[ View Holdings » ESG Pillar Score US3620146239
RisicModel [ View Owners } ESG Product Involvement US31617K1051
Workspace [ View Fundcode Info ESG Product Involvement Top Exposure US4642871507
«Bi Investment Lists ] Performance Attribution 4 Fixed Income Exposure Analysis US4642871507
E My Lists Portfolio Analysis Global Revenue Map
» &5 Search Criteria Average Detail Report Growth
» &8 Report Templates Stock Intersection Historical Allocation
i Chart Templates X-Ray Historical Drawdown
: : zi‘s‘:j:t;elahase Filing Historical Sustainability
B Soved Reports Documents Holdings Plot
5 Note Manager UK Closed End Fund News Holdings Similarity

MAORNINGSTAR
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 9: Update the Correlation Matrix chart settings

In the previous Price chart exercises, users investigated fund and benchmark data for a

specific time period (trailing five years). In this exercise, users will update the

time

period and update the color scheme. The default view displays a one-color scheme, but
a two-color scheme is available within Chart settings. The two-color scheme option
displays funds that are positively correlated in blue and funds that are negatively

correlated in yellow. To update chart settings, do the following:

1. From the Start Date drop-down field, select 5 Years Ago.

Exercise 9: Update the
Correlation Matrix
chart settings

Correlation Matrix  Actions v Edit Investments | O Reset Chart Export v

Q, Add to Chart

Start Date 5 Years Ago (11/01/2016) v | End Date Last Month End (10/31/2021) v Currency US Dollar v

1 2 3 4 5 6 7 8 9 10 1 1
1 PIMCO Investment Grade Credit Bond Instl .
2 DFA US Micro Cap | .
3 MFS International Intrinsic Value A .
4 American Funds New World A .
5 American Funds Washington Mutual A .....
6 Invesco International Small-Mid Com A ......
2. From the End Date drop-down field, select Last Quarter End.
Correlation Matrix ~ Actions v Edit Investments © ResetChart | Export v 2 Send Us Feedback :‘

Q_ Add to Chart

Start Date 5 Years Ago (10/01/2016) v I End Date Last Quarter End (09/30/2021) v | Currency US Dollar v 4 More Settings v

Note the updated
value for the
highlighted field.

5 American Funds Washington Mutual A
6 Invesco International Small-Mid Com A

7 Baird Core Intermediate Municpl Bd Inv

8 Loomis Sayles Core Plus Bond A . .. ...
9 GMO SGM Major Markets VI .. . .

10 Fidelity* GNMA

11 iShares Core S&P Total US Stock Mkt ETF

12 iShares Core S&P Total US Stack Mkt ETF ... ..

s [NEESEEE B BE

Note the updated

End Date 9 10 1 12 13
— T I Last Quarter End v I W 0.76t01.00
I Investment Grade Credit Bt £
W 05110075
value for the
2 DFA US Micro Cap | - 355‘”20 highlighted field.
.011t00.25
3 MFS International Intrinsic Value A 0.00to-0.24
-0.25t0-0.49
4 American Funds New World A B -050t0-074
B 075t0-1.00
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™

Exercise 10: Save a chart as a template

A user can save a chart as a template and retrieve it within the desktop access point of Exercise 10: Save a chart
Morningstar Direct. To save a chart as a template, do the following:

as a template

1. The Correlation Matrix should still be open in the Charts window. From the toolbar, click
Actions > Save Chart. The Save As window opens.

'{ Morningstar Direct

Correlation Matrix | Actions v

> Reset Chart

Export v

Save Chart

Star Copy to Clipboard

1 PIMCO Investment Grade Credit Bond Inst|

2 DFA US Micro Cap |

3 MFS International Intrinsic Value A

4 American Funds New World A

5 American Funds Washington Mutual A

6 Invesco International Small-Mid Com A

8 Loomis Sayles Core Plus Bond A

Currency US Dollar v

2. In the Name field, enter Correlation Matrix chart.

4 More Settings v

Click Save Chart.

M save As X

Save As

Name || Correlation Matrix chart || Name the temp|ate_

My Charts

oK Cancel Help
3. Click OK. The Save As window closes.
4. Click X to close the Charts window.
Morningstar Direct November 2021 18
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direc

tSM

Exercise 11: Generate a Historical Sustainability chart

The Historical Sustainability chart allows users to analyze a fund’s past ESG scores as a

time series to evaluate trends and changes in companies owned by the fund. It
displays a fund’s Portfolio ESG score on a monthly, quarterly, or annual basis. To
investigate a fund using the Historical Sustainability chart, do the following:

1. From the grid, right-click DFA US Micro Cap I. The right-click menu opens.

2. From the right-click menu, select Interactive Charts > Historical Sustainability. The

Historical Sustainability chart opens in a new window.

Home

File New Favorites JTools Help

Equity/Credit Research

Local Databases r

Performance Reporting [

| Morningstar Direct

My Lists

Action*| &4 A « ¥ View Snapshot

Name

Global Databases

: Search for

In This View -

View Vehicles

PIMCO Investment (

View Accounts With Holding

~ | M save K Add

Base
Currency

Go

Exercise 11: Generate
a Historical
Sustainability chart

Historical Sustainability

Asset Allocation 2 DFA US Micro Cap 1 e .
New ns
3 MFS Ints ti I I
Portfolio Management r oo ol View Transactions
[ a American Funds New i et
Portfolio Analysi Tk T
QLo AalVES s American Funds Was View Prices
Markets re Invesco Internations Edit Security
Asset Flows C 7 Baird Core Intermec Reports
Presenta Allocation Interactive Charts
Risk Mod:  Carbon Risk [T Risk Model
—— Correlation Matrix Presentation Studio Charts
Equity Region Exposure Premium/Discount
~&8 Inves i )
=1 ESG Pillar Score View Heldings
» 55 Searc ESG Product Involvement View Owners
» & Repot ESG Product Involvement Top Exposure View Fundcode Info
E Chart Fixed Income Exposure Analysis View Historical Instruments
» & Data
Global Revenue Maj View Historical Regions
» &8 Custa P =
B savec Growth X-Ray
E Note | Historical Allocation Performance Attribution
H Retire Historical Drawdown Portfolio Analysis
» & Groug

Filing

Holdings Plot

Heldings Similarity
Portfolio Characteristics
Price

Return Bar

Return vs Category
Revenue Exposure

Risk Reward

Rolling Return

Documents

View Funds

View Investment Options
View Euro Funds

View Wrappers/Policies

View Current Manage Funds
View Historical Manage Funds
View Subaccounts

View 529 Portfolios

Click the Historical Sustainability chart.

MAORNINGSTAR
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direc

tSM

Exercise 12: Compare two funds

In the previous Historical Sustainability chart exercise, users investigated the historical
sustainability data for DFA US Micro Cap I. In this exercise, users will compare the
historical sustainability data for DFA US Micro Cap | and American Funds New World

A. To compare the funds, do the following:

1. Click the Component Settings icon. The Component Settings window opens.

2. Click Comparisons. The Comparisons window opens.

W
*""‘“"’*\»—‘\.»/—\"j

Component Settings

ime Period

09/01/2015 - 02/28/2021
Data Point

Portfolio Sustainability Score

Frequency
Manthly

Benchmark
Momingstar US Small Cap TR USD

Exercise 12: Compare
two funds

Comparisons
0 Selected

Display Settings

Data View 3
Line Chart

3. Type American Funds New World A in the search field.
4. Select the first fund, then click Done. The fund is added to the Historical

Sustainability chart.

S
Name Identifier
American Funds New World A NEWFX

=4 American Funds New World F2 NFFFX
American Funds New World RE RNWGEX
American Funds New Warld F3 FNWEX
American Funds New Waorld F1 NWFFX
American Funds New World 5234 CNWAX
American Funds New World R4 RNWEX
American Funds New World R3 RNWCX
American Funds New World C NEWCX
Ameriran Funds Maw Wnrd RR RMWFY

@ @ &2

Click Comparisons.

'@_\, Comparisons | | g

| (O\ American Funds?xlew"."."or!dﬁl X :)l ;
S0

Exchange Type

Nasdag
Nasdag
MNazdag
MNazdag
MNazdag
Nasdag
Nasdag
Nasdag
Nasdag
Nazdan

A
Open-End Fund

Open-End Fund
Open-End Fund
Open-End Fund
Open-End Fund
Open-End Fund
Open-End Fund
Open-End Fund

Open-End Fund v
MNnen-Fad Fund

5. Click away from the Component Settings window to close it.

6. Click X to close the Charts window.

Note the highlighted areas.

MAORNINGSTAR
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direc

tSM

Exercise 13: Generate a Holdings-Based Style Trail chart and

Holdings-Based Style Map chart

The Holdings-Based Style Trail chart maps a fund's location on the Marningstar Equity
Style Box, allowing users to see the changes for the equity portion of the fund over
time. The Holdings-Based Style Map chart gives users a view of the holdings-based
style of a portfolio. This exercise shows you how to generate both of these charts in
Presentation Studio on one page.

To see these charts, do the following:

1.

In the desktop access point of Morningstar Direct, select the Workspace module. The
My Lists page opens.

Double-click the US Small Value Five Star Funds & ETFs list. The list opens in

the Grid.

Check the boxes next to the first five investments.

File MNew Favorites

Home

Equity/Credit Research
Local Databases
Global Databases
Performance Reporting
Asset Allocation
Portfolic Management
Portfolio Analysis
Markets

Asset Flows
Presentation Studio
Advanced Analysis
Workspace

&8 Investment Lists
B My Lists
¥ B8 Search Criteria
¥ &8 Report Templates
[E Chart Templates

Tools Help * Search for In This View

My Lists

- Ba

. Actionv| # A v ¥ View Snapshot

- | @save Ll Add [ Edit Datg

Exercise 13: Generate a
Holdings-Based

Style Trail chart and
Holdings-Based Style
Map chart

[ Name Base Ticker
Currency

v 1 Applied Finance Explorer Institutional Us Dollar AFDZX
v 2 Fidelity® Small Cap Value US Dollar FCPWX
v 3 FPA Queens Road Small Cap Value US Dollar QRSVX
v 2 Franklin Small Cap Value A Us Dollar FRWLX
v 5 MFS New Discovery Value 1 US Dollar NDWIX
s North Star Micro Cap I US Dollar NSMWYX
Oz Pacer US Small Cap Cash Cows 100 ETF US Dollar CALF
s Royce Special Equity Invmt US Dollar RYSEX
Mo VALIC Company I Small Cap Special val Us Dollar WSSV
710 Vanguard Small Cap Value Index Inv US Dollar VISV
D11 Victory Sycamore Small Company Opp R US Dollar GOGFX
Mz VictoryShares US SmCp Hi Div Vol Wtd ETF Us Dollar CSB
[T a3 Walthausen Focused Small Cap Val Ins US Dollar WSVIX
14 Wells Fargo Special Small Cap Value & US Dollar ESPAX

Check the boxes.

MAORNINGSTAR
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Exercise 13: Generate a Holdings-Based Style Trail chart and

T Holdings-Based Style Map chart

Viewing Charts, Reports, and Fund Holdings in Morningstar Direc

4. From the Action menu, select Presentation Studio Charts > HB Style Map. The
Holdings Based Style map opens in Presentation Studio.

Wi Morningstar Direct
file New Favorites Tools Help | Search for | In This View - Go
Home My Lists
Equity/Credit Research ;li,e\m'onv' A A v ¥ View Snapshot + | ™ sav|
Local Databases [ Save As » Base
Currency
Global Databases Add [To »
Performance Reporting Iv MOV pED utional US Dollar
Delefe
Asset Allocation O Settigs 2 US Dollar
Portfolio Management Iv Repdrts » sloe LS Dty
v US Dollar
Portfolio Analysi I
ortfolio Analysis ~ Intefactive Charts » US Dollar
Markets r Risk[Model 4 1 Nallge
T r Presentation Studio Charts  » Correlation Matrix =
Premium/Discount Floating Bar
Presentation Studio r i Bl i r
r—— N " 2 it r|  Select HB Style Map.
e [ ViewOwners » HB Style Map
Workspace r View Fundcode Info HB Style Trail -
~E8 Investment Lists El Performance Attribution 4 Holdings Similarity :
B My Lists r Portfolio Analysis RB Style Map r
» & Search Criteria [ Average Detail Report Relutn Bar -
» B8 Report Templates Stock Intersection Return vs Category
& Chart Templates X-Ray Rolling Window
:E Data Sets Filing Scatterplot
E Custom Database Documents Stacked Bar
=3 Saved Reports
iy UK Closed End Fund News Time Series Chart
B2 Note Manager
E Retirement Plans My Templates

5. Click the Divide Page icon, then select the first option in the Two Cell section.

1 Untitled Workbook * - Presentation Studio = [u} X
o3 Home | chart Data Table Format XmEd
% - L h B A = @ | o a8 O b @ &4 x

Click Divide Page.

Investments  Workbook | Page Chart Table Text Image ||DividePagh View | Calculate | Restore | PDF  PPT  XPS  Excel

Setting Tnsert

Two Cell Four Cell

Holdings Based style ttap | 117ee Cell Five Cell

10/31/2020
10/31/2020
12/31/2020
12/31/2020
12/31/2020

172021

Six Cell

Core-Grth High-Grth

6. Click in the right-hand side of the page to select it, then click the Chart icon.

Morningstar Direct November 2021 22
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™

Exercise 13: Generate a Holdings-Based Style Trail chart and
Holdings-Based Style Map chart

Select Style Analysis, then drag-and-drop the Holdings-Based Style Trail to the

right-hand side of the page.

[4 Untitled Workbook * - Presentation Studio

B ome

Legend
All Charts

My Components

DaspVal Core-val Cors  Core-GrthHigh-Grth

Holdings-Based Style Map

Small  Mid Large  Giant

Micro

Deep-Val Core-Val Core

Core-GrthHigh-Grth

Holdings-Based Styl

Deep-Val Core-¥al Core

le Trail

“ | Time Period: 1/31/2016 to 12/31/2020

Core-GrthHigh-Grth

Source: Morningstar Direct

Drag-and-drop the

Chart Data Table Format.
% - L] E A @ a2 & O By a x
Investments Workbook | Page |chart] Table Text Image | DividePage View | Calculate | Restore | PDF PPT XPS  Excel
Setting arkets [ tavou Calculate | Linking Export
s o i 2 B n 5 A 7 e g Lo
o
- set Exposure
toldings Analysis
Holdings-Based Style Map
b ttribution
napshot 8
1
Style Analysis
2 i . [r—
— e — ETEET -
Drag to Add A 2% =] 4o
Time Series ; —— highlighted chart
. . e | | e C ar
Asset Flows ing ing: Historical Returns-  Morningstar Style g g
3 Style Map Style Trail Style Map Style Bar Chart Based Style
Multiple Returns Stacked Bar Chart

Note the placement of the chart.
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Exercise 13: Generate a Holdings-Based Style Trail chart and
Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Holdings-Based Style Map chart

8. Inthe upper-left corner of the window, click the gear icon, then select Save.
9. Inthe Workbook Name field, enter Holdings-Based Charts, then click Save.

' 14 Untitled Workbook * - Presentation Studio
l ﬂ‘ ' Home Chart Data Table Format
Mew Workbook Ctrl+M L B A ] [am)
Open Ctrl+0 art  Table Text Image Divide Page
save cri+s || Insert Layou!  Click Save.
Save As 3

Save as Template

Export

Send To

Share With

Exit

In the next exercise, users will save this report as a Presentation Studio template.

Morningstar Direct November 2021 24
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 14: Save a Presentation Studio template

In the previous exercise, users created a Presentation Studio report using the Exercise 14: Save
Holdings-Based Style Map and the Holdings-Based Style Trail. In this exercise, users a Presentation
will learn how to save the report as a template. Saving as a template allows users to Studio template

re-open the report template with different funds. Saving as a report allows the users to
re-open the report only with the original fund(s).

1. In the upper-left corner of the window, click the gear icon, then select Save
as Template.

2. Inthe Workbook Name field, enter Holdings-Based Charts, then click Save.

|7 Untitled Workbook * - Presentation Studio
ﬁ Home Chart Data Table Format
New Workbook Ctrl+N Py 15 Years ago o JI_I
Open Ctrl+0 Start Date
Save Ctrl+S | Time Per|
Save As

Save as Template Select Save as Template.

Export

Send To

Share With

Exit

3. Inthe Template Name field, enter Holdings-Based Charts, then click Save.

Presentation Studio Iz[

Template Name |Holdings—Based Chartg |

Saved Templates

Name
= &3 My Templates 4

Sustainability Comparison (Custom Portfolio)

o Click Save.

Save l Cancel ‘

4. To learn more about Presentation Studio, read the Using Presentation Studio guide.
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https://morningstardirect.morningstar.com/clientcomm/PresentationStudio.pdf

Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 15: Generate the Global Fund Report

Morningstar Direct offers a variety of pre-created reports. These reports open as PDFs Exercise 15: Generate the
and cannot be edited, unlike the templates created in Presentation Studio. Global Fund Report

In the previous exercises, you practiced generating charts including as Presentation
Studio templates. The next couple exercises show some alternate reports you may
want to use as part of an investment analysis. To generate the Global Fund Report for a
qualified fund, do the following:

1. Select the Workspace module. The My Lists page opens.

2. Double-click the US Small Value 5 Star Funds & ETFs list.

3. On the toolbar, click Edit Data. The Select Data Points window opens.

Morningstar Direct

: File MNew Favorites Tools Help : Search for In This View - Go
Home | My Lists
Equity/Credit Research . Action~| # A v ¥ View Snapshot - | @ save ki Add|F3 Edit Data || Sort] Use this icon to add
Local Databases r Name Base Tickar 1SIN a data point and
Currency

discover which
funds can be used to
generate the Global

Global Databases
Performance Reporting Da Applied Finance Explorer Institutional us Dollar AFDZX US981474

T — | Fidelity® Small Cap Value US Dollar FCPVX Us5316339 Fund REpOft.

s FPA Queens Road Small Cap value us Daollar QRSWVX Us104826
Portfolic Management 5

4 Franklin Small Cap Value A US Dollar FRWVLX US355148
Saciialiednakicis s  MFS New Discovery Value I US Dollar NDVIX  US55278M
Markets | MNorth Star Micro Cap I US Dollar NSMWH USE65384
Asset Flows rz Pacer US Small Cap Cash Cows 100 ETF Us Dollar CALF UsS69374H
T s Royce Special Equity Invmt US Dollar RYSEX Us5730905

| ] WALIC Company 1 Small Cap Special val us Daollar VESVX US91915R
Advanced Analysis

M 10 Vanguard Small Cap Value Index Inv US Dollar VISVX Us5922908
loskspacs [T 11 victory Sycamore Small Company Opp R Us Dollar GOGFX Us926464]
+E5 Investment Lists M 12 VictoryShares US SmCp Hi Div Vol Wtd ETF us Dollar CsB US92647N|

E My Lists M i3 Walthausen Focused Small Cap val Ins US Dollar WSWIX US933310

» &5 Search Criteria [T 14  wWells Fargo Special Small Cap Value A US Dollar ESPAX 5949348
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 15: Generate the Global Fund Report

4. From the View drop-down field, scroll down and select Morningstar Ratings

and Grades.
Select Data Points b4
Select Data Points
Choose a Universe, then locate data points by selecting an existing view, or searching by
name. To change the general or calculation settings of a selected point, use the Settings button.
Available Data Lists
Universe COpen End Funds w~
Find Data Point By @ Wiew O MName containing
Snapshot w
All Standard Data Points ~
Snapshot
Available Data Points |Sustainability
. Operations
Total Data Points: 147 MIFID
Name Firm Level Data
Base Currency Operations (Global)
Virtual Class Returns (Daily)
Ticker Returns (Month-End)
ISIN Returns (Quarter-End)
Global Broad Cateqory GrgReturns (Calendar Year)
Global Category Dividend {Calendar Year)
Morningstar Category Estimated Share Class MNet Flow (Month-End)
Morningstar Institutional g Estimated Fund-Level Net Flow (Month-End)
Post-tax Returns {Daily)
Post-tax Returns (Month-End)
. Post-tax Returns {Calendar Year) Select this view.
Selected Data Points  |Risk - Total Return (Month-End)
) Fisk — Total Return (Quarter-End
Total Data Points: 63 Morningstar Ratings and Grades
Aszet Allocation
Eame CAN Asset Allocation A
5. Scroll down to select Morningstar Analyst Rating, then click Add.
Select Data Points b4

Select Data Points

Choose a Universe, then locate data points by selecting an existing wview, or searching by
name. To change the general or calculation settings of a selected point, use the Settings button.

Available Data Lists

Universe Open End Funds e

@ View

Marningstar R.atings and Grades w

Find Data Foint By O Mame containing

Available Data Points

Total Data Points: 67

Select this data point,
then click add.

Research Flagship Fund - Y A

Morningstar Analyst Rating

Morningstar Analyst Rating - Process Pillar

Marningstar Analyst Rating - Performance Fillar

Morningstar Analyst Rating - People Pillar

Marningstar Analyst Rating - Parent Pillar

Marningstar Analyst Rating - Price Pillar

Flagship Fund Analyst Rating

Flagship Fund Share Class Id W

| add I Add Al |

Selected Data Points

Total Data Points: 68

Name ~ | A

o
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 15: Generate the Global Fund Report

6. Scroll to the bottom of the Selected Data Points area, select the Morningstar Analyst
Rating data point just added, then click the Move to Top button.

Select Data Points b4
Select Data Points
Choose a Universe, then locate data points by selecting an existing view, or searching by

name. To change the general or calculation settings of a selected point, use the Settings button.

Available Data Lists

Universe Open End Funds i
Find Data Point By @ Wiew O MName containing
Morningstar Ratings and Grades w

Available Data Points

Total Data Points: 67

Research Flagship Fund - A
Maorningstar Analyst Rating - Process Pillar

Marningstar Analyst Rating - Performance Fillar

Morningstar Analyst Rating - People Pillar

Marningstar Analyst Rating - Parent Pillar

Marningstar Analyst Rating - Price Pillar

Flagship Fund Analyst Rating

Flagship Fund Share Class Id W

Add Add Al |

Selected Data Points
Total Data Points: 69

Price Data Ready A~
Cperations Data Ready

Portfolio Data Ready

Note Effective Date

I

[~ ]
Related Notes "

2

Use this button to
move the selected data
point to the top of the list.

Primary Share in GIFS Classification
Target Date Report Date

Settings Remove Remove Al |
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 15: Generate the Global Fund Report

7. Click the Down button twice to move the Morningstar Analyst Rating data point down
two spots, so it is just before Ticker.

Select Data Points b4

Select Data Points

Choose a Universe, then locate data points by selecting an existing view, or searching by
name. To change the general or calculation settings of a selected point, use the Settings button.

Available Data Lists

Universe Open End Funds i
Find Data Point By @ Wiew O MName containing
Morningstar Ratings and Grades w

Available Data Points

Total Data Points: 67

Morningstar Analyst Rating - Process Fillar

Marningstar Analyst Rating - Performance Fillar

Morningstar Analyst Rating - People Pillar

Marningstar Analyst Rating - Parent Pillar

Marningstar Analyst Rating - Price Pillar

Flagship Fund Analyst Rating

Flagship Fund Share Class Id W

Add Add Al |

Selected Data Points
Total Data Points: 69

Note the final location
for this data point.

Global Broad Category Group

Global Category

Morningstar Category

Morningstar Institutional Category v

Bl

8. Click OK to close the Select Data points window. The Grid refreshes.

9. Check the box to the left of a fund with a Morningstar Analyst Rating of Gold, Silver,
or Bronze.

Marningstar Direct November 2021 29

MOHMNHSTAH © 2021 Morningstar. All Rights Reserved.



Viewing Charts, Reports, and Fund Holdings in Morningstar Direc

tSM

Exercise 15: Generate the Global Fund Report

10. From the Action menu, select Reports > Global Fund Report. The PDF opens in a

new window.
Morningstar Direct
File MNew Favorites Tools Help Search for In This View * Go
Home My Lists
Equity/Credit Research | # A~ w ¥ View Snapshot - |BSave Ed Add |§
Local Databases r Save As 3 Base Ti
Currency
Global Databases Add To k
Performance Reporting r Hove o utional US Dollar AR
Delete
Asset Allocation r . U= Dollar 23
— r Settings alue Us Dollar [o];
pasifoloianagsmant rl Reports 12 Global Fund Report I
Portfolio Analysis r Interactive Charts + Model Portfolic Report
Markets r Risk Model 4 Fund Sustainability Report
T r Prese.ntatlolj Studio Charts 3 Fund Carbon Repart
) ) r Premium/Discount Closed End Fund Report
Presentation Studio . . ;
r View Holdings L4 Morningstar Research Report (AUS)
SduaocelAnoly=is I View Owners L4 Stock Research Snapshot
Workspace r View Fundcode Info Investment Detail - Basic
~E3 Investment Lists r Performance Attribution 4 Investment Detail - Advanced
B My Lists r Portfolio Analysis Investment Detail
» B8 Search Criteria r Average Detail Report Narratives PDF
» B8 Report Templates Stock Intersection Marningstar Page
H Chart Templates X-Ray Morningstar Report/Quicktake
3 A £
: DakaSels g Filing Quicktake POF
4 Custom Database .
B 7R i Documents Target Date Series Report
b bt bt UK Closed End Fund News : :
B Note Manager Comparison: Holdings
Morningstar Direct = O X

Save this report to the Saved Reports area in order to access it later from any location. To e-mail this report directly from this screen, click the E-mail button.

Select this report
from the Action menu.

Report Title
save ||[Downloa]| | cClose || e-mail | [Feedback| | Help |
o
B & 8 B Q @ s ) 2 © @
~
O o
Morningstar Ansiyst Rating
Vanguard Small Cap Value Index Inv OSier i
m V|SV)( 11:13, UTC0800 2:
Momingetar Catsgory Total Assets lscoption Dats  Domsicile. Currsacy Morningstar Rating
US Fund Small Value Russall 2000 Valu TR USD 31824 05/21/38 usA uso Jekokeok
@ Miluso
Style Map an | w2 | a3 | mw | ams | ms | an | mom | am | mo | am Performance 01312
1 v Gotaoom Ve e
Annusiced USD usD %
Q £ k3 u fund /308 1007
& ey =ategary zoe 816
== H ™ e w0 s
el = — v Full anager Crange
4 . 2 H T p Pl Marger Crarge 4
= [ = Sear Matket
Momingszs Rateg
Do Wk B G i ¥ o
= £ #
Quartile Rank in Categor
o Expoar =E=E=EEEE EEEE RS
51 2 a7 2 » 62 2 . 3 kg 65 Percentile Rank in Category
!Q 382 ko %9 3% @ a5 4 419 | 416 - # of Funds in Category
4.16 | 1856 | 3641 | 1039 | 478 | 2465 167 [ 12 6 572 208%  Towal Retum USD
028 256 018 705 19 | 43| 313 a2 118 1| 87 +/- Categary
B & | Asiad 34| os1| 189 | 607 | 269 | 709 | 383 | 082 | 02| 103 | 318 4o
e (5 | Ak -
WE%  |04% 00% Tocess
= EEEE"HEEEHEE
Peopls Aszet Allocali
- 00000000000 === .. I
William A. Coleman 04116
L 0, L44E Sucer Sactor b

11. Click X to close the report window.

Click Download to
download the report
to your desktop.
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direct™ Exercise 16: Generate the Morningstar Report

The Morningstar Report, (formerly known as the Quicktake report) opens in an Exercise 16: Generate the
browser window. To generate the Morningstar Report from the grid view, simply Morningstar Report
double-click the name of a fund. Scroll up and down the page, or use the navigation

menu at the top to move to a specific section of the report.

Use these controls to navigate
to different parts of the report.

Quote Analysis Performance  Risk Price Portfolio People Strategy Parent

Applied Finance Explorer Fund Institutional Shares AFD7X Y % % % % 3 Gold @

NAV / 1-Day Return Total Assets Adj. Expense Ratio (O] Expense Ratio Fee Level Load
1494/ 0.20% 60.2 Mil 0830% 0.830% Below Average None
Category Investment Style Minimum Initial Investment Status TIM Yield Turnover
US Fund Small Value ﬁ Small Value 10,000 Open 0.44% 229%
USD | NAV as of Jan 28, 2021 | 1-Day Retum as of Jan 28, 2021, 5:45 PM CST | Quantitative Rating as of Sep 30, 2020, 5:00 AM

Quantitative Take

Morningstar's Analysis @

Process® Sep 30, 2020 Peaple® Sep 30, 2020 Parent? Sep 30, 2020

@® High @ High Above Average
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Viewing Charts, Reports, and Fund Holdings in Morningstar Direc

Exercise 17: View a fund's holdings

Charts and the pre-canned reports are two ways to analyze investments in Morningstar
Direct. For managed investments, a third option is available for users needing to
examine underlying holdings. To view a fund's full set of holdings, do the following:

1.

3. Click the date icon on the toolbar to select a previous portfolio for the same fund.

The US Small Value 5 Star Funds & ETFs list should still be open in the grid view. Check
the box to the left of a fund in the list.

From the Action menu select View Holdings > Detailed Holding Analysis. The
holdings open in a new window. They are sorted in descending order by weight.

Morningstar Direct
Eile

Home

Local Databases
Global Databases
Performance Reporting
Asset Allocation
Portfolio Management
Portfolio Analysis
Markets

Asset Flows
Presentation Studio
Advanced Analysis
Workspace

&3 Investment Lists
E My Lists
» B8 Search Criteria
» B2 Report Templates
B Chart Temnlates

New Favorites Tools

Help Search for

My Lists

r

Equity/Credit Research | Adiunvl # A w ¥ View Snapshot

In This View 7 5a

T BSave -

Exercise 17: View a
fund's holdings

b A e e e e Rl e R R R Ml Rl B |

Save As L4 fase

add To , Currency

Move To utional Us Dollar

Delete Us Daollar

Settings ¥ Value Us Dollar

Reports 4 Us Dollar

Interactive Charts 4 Us Dollar

Risk Model L4 Us Daollar

Presentation Studio Charts * s 100 ETF Us Dollar

Premium/Discount USs Dollar

View Holdings L Top Ten Holding Analysis

View Owners 4 Detailed Holding Analysis Sel hi :
View Fundcode Info Historical Holding Analysis mesee(;tat”?&%tifgs
Performance Attribution 3 Peer Holding Analysis for a fund.
Portfolio Analysis p val Ins Us Dollar

Average Detail Report value A US Dollar

Stock Intersection
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i fle New Favorites Help

Applied Finance Explorer Ins...

. Action~ View Portfolio
| Name

Oz Clearway Energy Inc Class C
s Herc Holdings Inc

a United Therapeutics Corp

s Innoviva Inc

s Darling Ingradients Inc

iz Group 1 Automative Inc

[ ] Hilltop Holdings Inc

(i) Synaptics Inc

[T 10  Builders FirstSource Inc

[T 11 Methode Electronics Inc Class A
[T 1z  Virtus Investment Partners Inc
[T 13  Diodes Inc

[T 14  stifel Financial Corp

Search for

1 Federated Hermes Treasury Obl IS

~ Snapshot

In This View > Go

¢ | i Send us feedback

4 b x
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Weighting %
TOIXX US60934N5002 60934N500 3.29
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SYNA US87157D109 87157D109 1.45
BLDR US12008R1077 12008R107 1.45
MEI US5915202007 591520200 1.45
VRTS US923828Q109 92828Q109 1.45
DICD US2545431015 254543101 1.44
SF US8606301021 860630102 1.43

+ Position

Markst Value

804,7597.00
530,675.00
443,023.00
421,348.00
385,117.00
379,518.00
376,266.00
373,080.00
357,052.00
355,843.00
355,547.00
354,361.00
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351,228.00

Shares

804,797.00 A
18,845.00
9,987.00
3,139.00
35,626.00
8,826.00
3,547.00
16,356.00
4,657.00
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11,555.00
2,221.00
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Note the sort order
being used by default
in this window.
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Exercise 18: Retrieve a fund's owner information

Morningstar Direct can also help you identify any fund of funds investing in a particular
fund. This function is useful when identifying any funds investing in another fund. The
analysis highlights the following information:

» the date of the portfolio for each fund owning the selected fund
» the weighting the subject fund represents in each owning fund, and
» the position market value of the subject fund in the owning fund.

< Note: This option is also valid for identifying funds investing in certain stocks.

To retrieve owner information, do the following:

1.

The US Small Value Five Star Funds & ETFs list should still be open in the grid view.
Check the box to the left of a fund in the list.

From the Action menu, select View Owners > Detailed Owner Analysis. The owners

open in a new window.

Exercise 18: Retrieve
afund's
owner information
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